Introduction

CaseMap 4 offers loads of new features, including a revamped interface, new spreadsheets to organize legal research, and additional ease-of-use features, e.g., live spell checking.

We’ve created this document to explain which CaseMap 3 features have been moved, renamed, or eliminated in CaseMap 4.

“What Went Where in CM4” does not review the many enhancements and new features in CM4. These features are overviewed in “What’s New in CaseMap 4,” available on CaseMap 4’s Help menu and in PDF form at www.casesoft.com.

The Song Remains The Same

Despite CaseMap 4’s many new features and very different look, 99% of what you know about using CaseMap 3 applies to CaseMap 4.

First, CaseMap’s basic mission hasn’t changed one iota: CaseMap 4 is still the place to organize and explore your thinking about the facts, the issues, and the cast of characters in every case. It remains uniquely suited for use from the first days of work on any new matter.

Second, the basic method for working up your case files remains identical: Start each case file by building a cast of characters on the Object spreadsheet. Next, build an initial issue outline on the Issue spreadsheet. Then, begin your Fact chronology.

Third, the fields CaseMap 4 automatically creates for Facts, Objects, Issues, and Questions are virtually identical to those created by CaseMap 3. (The two minor changes are explained in this document’s final topic.)

Finally, all of the shortcuts to effective use of CaseMap 3 work in CaseMap 4. For example, the best way to hide or insert fields in your spreadsheet remains right-clicking on a field header.

Say Spreadsheet, Not Tab

In CaseMap 4, there’s a new way to display the spreadsheets where you organize case knowledge. Rather than clicking Tabs as you did in CaseMap 3, you click buttons on CM4’s Sidebar.

In CaseMap 3, we referred to locations by their tab, e.g., “Use the Fact tab to build a master chronology of case facts.” You’ll find that it’s easy to transition to CM4 if you start substituting the word “spreadsheet” any time you previously would have said “tab,” e.g., “Use the Fact spreadsheet to build a master chronology of case facts.”

Customizing the Sidebar in CaseMap 4: You can drag buttons from one section of the Sidebar to another. For example, the default location for the shortcut to the Question spreadsheet is on the Other Shortcuts section of the Side Bar. If you would prefer that the Question spreadsheet shortcut appear in the Main Shortcuts group, drag it to this section.
**Say View, Not Table**

In CaseMap 4, the collection of fields that appears on a spreadsheet is called a “View,” not a “Table” as in CaseMap 3. You can have many views of each of the spreadsheets in a CaseMap file, e.g., many views of the Fact spreadsheet.

In keeping with this terminology change, CaseMap 3’s Table Maker dialog box has been renamed the Define Views dialog box. You’ll find the Define Views option on CaseMap 4’s View menu.

**New Buttons For Adding and Deleting Spreadsheet Rows**

In CaseMap 3, the + and - buttons that appeared above the right side of each spreadsheet allowed you to add and delete spreadsheet rows. In CaseMap 4, the + button has been replaced by the New button found at the left end of the Standard toolbar. The button is now the icon that appears just to the right of the Print Preview button on the Standard toolbar.

Please note that the INSERT key on your keyboard remains the quickest way to add new rows to a spreadsheet. No need to pick up your mouse and click the New button — just press INSERT.

**Other Missing Toolbar Buttons**

In Version 4, we’ve overhauled CaseMap’s toolbars and the buttons displayed on them.

You now have the ability to control what buttons display on the toolbar and where they’re located on it. As such, we’ve limited the default set of toolbar buttons to those most commonly used. If you frequently use CaseMap features for which no default shortcut buttons are available, you can add buttons for these features. To do so, select Customize on the Tools menu, and then select the Commands tab in the Customize dialog box.

Second, when we did away with CaseMap 3’s tabs, we also eliminated the toolbar that appeared at the top of each tab. Some of the buttons that appeared on the tab toolbars were moved to the Standard toolbar. Others were left as options you can add to the Standard toolbar via customization.

Finally, a few buttons have been eliminated entirely as the features they invoked have been removed from CM — see the Goners item below.

**Changing Object Type Spreadsheets**

In CaseMap 3, a drop-down list at the top of the Object tab was used to change the display from one type of object to another, e.g., to change from a spreadsheet of Persons to a spreadsheet of Documents. In CaseMap 4, there’s an enhanced version of this feature called the Shortcut List.

Here’s how to find the Shortcut List: Look for the name of the current spreadsheet (it appears next to the Back/Forward buttons at the right side of the application). Place your mouse pointer over the spreadsheet name and you’ll notice the name changes color, letting you know it’s really a button.
Click the spreadsheet name and the Shortcut List appears. The Shortcut List displays all spreadsheet options including each specific object type, e.g. Persons, Documents. Click an item in the Shortcut list and your spreadsheet changes.

You may prefer to keep the Shortcut List open at all times and use it in lieu of the Sidebar with its larger buttons. When you display the Shortcut List, you'll notice a Push Pin icon at the top of the list that gives you this option.

**Data Refinery Out, Advanced Search In**

CaseMap lets you run two kinds of searches: “filters” and “tags.” Filtering limits the items in your spreadsheet to those that meet your criteria. Tagging marks items of interest with an icon but leaves all spreadsheet rows in view. In CaseMap 3, you could run two tag operations simultaneously. In CaseMap 4, you can only run one tag operation at a time (though you can run a filter and a tag at the same time).

In CaseMap 4, we eliminated the Data Refinery “pipeline” graphic found in CaseMap 3 while preserving the ability to create sophisticated searches. We’ve renamed the Data Refinery dialog box the Advanced Search dialog box. When you need to construct an intricate query, select Advanced Search on CM4’s Records menu.

[![Spreadsheet Example](image)](image)

*CaseMap 4's enhanced Instant Search feature makes it easy to build sophisticated searches.*

More importantly, we expect CaseMap 4’s enhanced Instant Search feature to drastically limit your need to use the Advanced Search dialog box. Instant Searches are searches you run by right-clicking a value in a spreadsheet and choosing options on the shortcut menu. We introduced Instant Searches in CaseMap 3, however, they could only be based on a single criterion. In CaseMap 4, you now can create Instant Searches based on two or more criteria, e.g., create an Instant Search that limits the facts in view to those that are both undisputed and linked to a particular issue. To create an Instant Search based on multiple criteria, simply repeat the process of selecting a spreadsheet value on which you want to search and clicking Filter By Selection or Tag by Selection on the shortcut menu. As you repeat the process, your spreadsheet updates to reflect the results of the new compound search.

Again, the ability to create compound searches using CM4’s enhanced Instant Search feature should mean that you’ll be able to complete 90%+ of all searches without using the Advanced Search dialog box.

**Tildes Out, Dashes In**

In CaseMap 3, a tilde (~) would appear when you entered an Object Short Name in a fact or other description field. The tilde was CaseMap’s way of letting you know the object had been recognized and linked. In CaseMap 4, the tilde has been replaced by dashed underlining.

In CaseMap 3, the default behavior was to show tildes in front of an object only as you edited a cell. In CaseMap 4, the new default behavior is to underline linked objects at all times, not just in the cell being edited. Again, this is CM4’s default behavior. If you would prefer that objects be underlined only in the cell you’re editing, you can make this change using the Object Display Options on the View menu.

Please note that object underlining does not appear on printed reports.
**Enhanced Add Object On The Fly**

Suppose you’re entering a fact and need to add a new witness or organization to the case file so you can refer to it by its Short Name. There’s no need to jump to the Object spreadsheet to add this new player. Just right-click the Fact Text cell and select Add Object on the shortcut menu.

When you used the Add Object feature in CaseMap 3, a full Detail Window appeared. When you use the Add Object feature in CaseMap 4, a special Add Object window appears instead. Simply select an object type and enter the object’s name. You're done. The object you add on the fly is automatically inserted in the Object spreadsheet and linked to fact you’re entering.

You can use the Add Object feature, not just in the Fact Text field, but in any of the 15+ CaseMap fields that permit the use of Short Names. These fields display a chain link icon to the right of their names.

Again, to add an object on the fly as you enter facts or other descriptive info, right-click and select Add Object on the shortcut menu. Or use the keyboard shortcut CTRL+A.

**Goners**

As we revamped CaseMap to create Version 4, we eliminated a few CM3 features entirely. These were features that very few users employed, and as a result, were not providing a sufficient return on the energy needed to learn them.

The Object Dictionary is gone. Use CaseMap’s Link Assistant tool in its place. When you need to search for a Short Name as you enter a fact or other descriptive info, press CTRL+SPACE to display the Link Assistant. Search the list of Short Names by typing the first letter of the name for which you’re hunting.

Fact Bookmarks are gone. If you liked this feature of CM3, consider creating a custom check box you use to mark the facts you would have bookmarked.

The Date Navigator is gone. To find a date in your CM4 chronology, use the Find dialog, which we’ve enhanced to work in Date fields. To display the Find Dialog box, select Find on the Edit menu or press CTRL+F.

The Historical Facts dialog box is gone.

**A Few Other Changes**

Here are a few other minor CaseMap 4 changes to note:

**Issue Dragging:**

You can no longer use drag and drop to move items in the Issue outline. We hope you’ll feel that the new compass icon tool for repositioning issues is a superior method for doing so. When you select an issue in CM4, a compass icon appears just to the left of the selected row. Click the north, south, east, or west directional arrows to move the selected issue up, down, right, or left in the outline.

**Role in Case:**

In CaseMap 4, we’ve expanded the size of the Role in Case field from 100 characters to 10,000. Given this increased size, we eliminated the Object Display Option that permitted an object’s Role in Case to be inserted in parentheses after each occurrence of an object’s name. We’ve replaced this feature with a new pop-up Role in Case hint. Select a Fact Text cell or any other description cell. Place your mouse pointer over any object that displays dashed lines below it and a hint will appear providing the object’s Role in Case and other information about it.
Bates Numbers:
When you create new case files, you’ll discover that CaseMap 4 now creates a Bates - Begin field and a Bates - End field, rather than a single Bates range field, as had been the default in CaseMap 3. Please note that files you convert from CaseMap 3 to CaseMap 4 will not have these two fields, but rather will retain the Bates range field. If you wish to move to the new set up, you can rename the existing Bates field Bates - Begin and create a new text field named Bates - End.

In CaseMap 3, the default Short Name for documents was created by taking the first 35 characters of the document’s Full Name and eliminating spaces. In CaseMap 4, unless you’ve created your own custom Short Name for a document, when you enter a value in a document’s Bates - Begin field, CaseMap 4 copies this value into the document’s Short Name field. If you have not assigned the document a Full Name, CaseMap also copies the Bates - Begin value into the Full Name cell. Except for the handful of documents that are so critical to the case that the trial team has created nicknames for them, using the beginning Bates number as the Full Name and Short Name of documents is generally simpler than trying to create meaningful names. There’s also an important benefit to this practice when you’re entering facts that you’ve culled from a document. After you enter the fact and want to reference the document as the Source, just flip to the first page of the document and type in the Bates number you find there. Since the Bates number is also serving as the document’s Short Name, your fact is instantly linked to the document itself.

Conclusion
We believe that you’ll be up and running with CM4 in no time flat. If you haven’t already done so, please read “What’s New in CaseMap 4” to learn more about the new and enhanced features. “What’s New in CaseMap 4” is available in PDF form at www.casesoft.com and is also available on CaseMap 4’s Help menu.

Thank you for being a client!